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CHAPTER 1 - Introduction

The development system for the ST18950 DSPs consists of the following components:

• Target hardware (DSPlug or ISA based emulator)

• BoxView � Debugger Graphical User Interface

• BoxServer (optional) server used for remote access

This manual describes the second component of the above configuration. Description of the other
components can be found in the separate documents.

Software components need to be installed first. System software requires 32-bit operating system
(Windows 95/98/NT). System software can not be run on earlier versions of the Windows PC
operating system (Win 3.1, 3.11), even if the Win 32s option is installed.

1.1 - Quick Installation

Software is supplied on the installation disk. Execute program setup.exe, this will create all directories,
copy files and install default shortcuts in the program group.

Installed software can be removed from the host computer using standard Windows� procedures
(Add/Remove Programs at Control Panel).

BoxView can be invoked directly for the different target configurations without any additional changes.
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CHAPTER 2 - Tutorial

Installation will create following shortcuts in the new program group:

• BoxView shortcut configured for the debugger execution.

• BoxView Help � this will invoke Help system

Multiple configuration can be created within the program folder. The debugger configuration is saved
in the configuration file specified with the command line option -s within the shortcut properties. The
default configuration file is called BoxView.ini. Custom configuration will have different command
lines.

BoxView after invoking the program will initialize windows in the following setup:

Software can support various DSPs, so window contents can not be initialized before selecting the
target device.
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Fig.1 - Shortcuts created by setup

Fig.2 - Initial windows layout



If the target device is specified correctly in the .ini file, simple CONNECT command can be used.
Initialization process will take a few seconds. System is initializing connection with the target device.
For customization or connection to the different target Open Connection dialogs needs to be used
(available in Options pull down menu).

For the initialization, proper Target type needs to be selected and LPT# or base I/O address specified.
Above dialog also allow to select remote target DSPs. Remote target initialization procedure involves
selecting BoxServer�s IP address (default: boxserver.softbox.com), performing the �QUERY�, to find
out number of the devices, and devices types on the remote end. After selecting desired device from
the list, system will connect and initialize its operation. Used devices will show IP addresses of the
users connected through the BoxServer.
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Fig.3 - Open Connection dialog

Fig.4 - Available Interface Types



2.1 - Command line parameters

To allow target configuration at the program start-up, command line parameters can be specified. All
target reference options, can be also set within the Open Connection dialog (Options pull-down
menu).

For multiple configurations, it is recommended to use custom file name for the system �INI� file.

-Sname File name to save windows settings on exit

2.2 - Function keys

Defined standard function keys:

F1 Help

F5 Go

Shift-F5 Halt

F6 Activate next debugger window

F7 Go to the cursor (Code window only)

F8, F11 Step

F9 Toggle breakpoint at the cursor (Code window only)

F10 Next (jump over subroutines)

2.3 - Mouse Operation

The left-click sets the cursor within the window, right mouse click invokes local window menu, to set
window options.

To facilitate running the target code, special mouse processing within Code window is added:

Double left-click toggles the breakpoint (same as F9 key).
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2.4 - Sample session

Select target type the PC is connected to. For the DSPlug taget, referenced as EMUST950PP, LPT
number needs to be selected. For the ISA based emulator, I/O bas e address needs to be entered.

If the target is installed on the remote workstation, conection needs to be specified through the TCP/IP
interface. After entering the IP address or alias name, and the port numer used for the socket
connection, Query button will initialize communication with the server. The Target Select box will show
available targets at the remote site.

When the OK button is pressed in the above dialog, system will start initialization to the target
preocessor - local or remote.

If the problem is detected during interface initialization, error message will be disaplyed, and the Open
Connection procedure needs to be repeated.

After connection to the target is initialized, the debugger will display the data from the DSP

12 BoxView User Manual
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Fig.5 - Remote Connection to Server



Next sample program can be loaded. To load the object file, �load� command can be used, but to
specify additional load options Load File dialog should be used (pull-down menu LoadFile):

The details of the above dialog are discussed in the following chapter. For the purpose of the tutorial,
we will need only to select the file name, with the �File� button. This will open standard Windows file
selection dialog:

BoxView User Manual 13

Tutorial

2

Fig.7 - Load File Dialog

Fig.6 - After System Initialization



We will select sample ASM program � demo2.s19

• Set a breakpoint at �mainloop� with the �BREAK mainloop� command within the command
window.

• Start code execution: GO

• Display data memory using symbolic entry: DISPLAY AM_WAVE

After those steps, debugger windows should look as follows:

Some of the above commands could be also executed using �Symbols� dialog. This dialog can stay
open for the whole debugging session. To open this dialog, use View-->Symbol pull-down menu.

14 BoxView User Manual
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Fig.9 - After Loading

Fig.8 - File selection dialog



Symbols dialog allows to set breakpoints, add items to the Watch window, set display address for the
Memory and for Code windows, and start program execution to the temporary breakpoint.

Additional features of the above dialog are described in the following chapter.
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Fig.11 - Symbols Dialog

Fig.10 - Selecting Symbols Window



To execute the program with the �automatic� screen refresh, set a brekpoint at address P:110 with the
�show� attribute. This can be done with double-click or function F9 key, while the Shift key is
depressed. Also �show� attribute can be set with the Software Breakpoint dialog. The address p:100 is
inside the outside loop. Every time the execution stops at this address, sine wave was updated at
Y:1000 address. To observe the sine wave in the graphical format, execute: GRAPH AM_WAVE.

Variables can be added to the Watch window using the Watch command, or by pressing the Watch
button within the Symbols window.

Once the variable is added to the Watch window, it can be expanded (arrays, data structures,
pointers) by double-clicking on the line to be expanded or collapsed.

To remove the item from the Watch window, you can press Del key when cursor is on the line to be
deleted.

Run code in the continuous stepmode (Shift-F8 or ProcessContStep). Last selected Code windowwill
follow program counter, opening correct source file for the display. Other Code windows will show PC
(right yellow arrow) only if it is within lines displayed.

Following Figure will show few other windows opened. All windows will be described in the following
chapter.

16 BoxView User Manual
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Fig.12 - Setting the Breakpoint
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Fig.13 - Multiple windows opened
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CHAPTER 3 - BoxView Reference

3.1 - Calls Window

Calls window shows the call stack. It allows also to change the program frame pointer used for
variables display. If the frame is different from the real one- green triangle is displayed. This will affect
local variables displayed within the Watch window

3.2 - Code Window

Code window displays debugged program in one of three modes: source, assembly or mixed. Display
modes can be selected either from the window local menu (by clicking on the window�s icon on the left
side of the title bar), or by entering SRC, ASM or MIX commands within command window.
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Fig.14 - Call stack window

Fig.15 - Code window in source mode

Fig.16 - Code window in mixed mode



Below is the layout of the local menu for the command window:

Local menu can be activated with the right-mouse button. Following functions can be accessed from
this menu:

• execute code to the cursor (this is possible only for the code executed out of RAM). After
reaching the desired location, temporary breakpoint is removed automatically. The same
effect can be accomplished with the F7 function key.

• invoke inline assembler to modify the line of code

• set the mode of the Code window: Asm, Mix or Src. This can be also done with the
commands from the command window (ASM, MIX, SRC). If the command is executed from
the command window, it will affect only last selected code window (in case that multiple
code windows are open).

• change font size for this window. The global font selection is available from main pull-down
menu: Options-->Font.

• disable/enable display of the opcode values. If the option �No Opcodes� is checked, no
opcodes will be displayed, so the code can be displayed in the smaller window.

• enable/disable selection margin. With the selection margin enabled, small icons are
indicating attributes of the particular line within code window. If the margin is disabled,
attributes ar indicated by color of the background/foreground for the displayed code line.
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Fig.17-Code window�s local menu



Following attributes are displayed with icons and/or colors:

• current PC value: yellow arrow

• selected frame: green triangle

• SW breakpoint: dark red circle

• SW breakpoint with �show� option: light red circle

• disabled SW breakpoint: red empty circle

3.3 - Command Window

Command window allows for entering text commands. It saves the history of executed commands.
Old commands can be edited and/or reexecuted. Pressing Enter key when the command line is
empty will repeat the last command.

3.4 - Memory Window

Memory window allows to display contents of the DSP memories. Starting address to display can be
set from the Command window, using Display command, from the Symbol window by selecting the
symbol and pressing the Display button.
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Fig.18 - Command window

Fig.19 - Memory window



The change of starting address can be modified with the command DISPLAY, or by direct editingof
the address field . The memory contents can be also directly edited within the window. The highlited
portions of the memory window can be copied to the window�s clipboard area, and pasted to any other
application.

The local menu of the memory window (right-mouse button) allows for disabling of the address
display, so more data can be displayed within the window. The current address, where the cursor is
located, is displayed within the window tile. If address corresponds to valid symbol, symbol also will be
displayed at the window title.

3.5 - Register Window

Register window displays contents of the DSPs core registers. Number and format of the registers
displayed depends on the DSP type. Value of any core register can be modified with the CHANGE or
SR commands, or by direct editing of the register value.

BoxView allows for multiple Register windows to be displayed.

3.6 - Graph Window

Graph window allows to display content of the memory in the graphical format. Single pixel on the
horizontal axis represents one memory location. Vertical axis represents the memory value. Vertical
axis can be scaled with up/down arrows. Scale can range from single increment per pixel, up to
maximum memory value per graph height. There is also logarithmic sace available.
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The local menu available with the right-mouse button, allows for following controls:

• Change font size - this afects index and value at the cursor display

• Sign toggle - allows for formatting the graph in signed or unsigned mode

• Index toggle - enables/disables display of the memory value scale on the left side of the
window

• Scroll bar toggle - displays/hides the horizontal scroll-bar

• Cursor toggle - enables display of the cursor. Value at the curosr position is displayed in the
upper right corner of the window. Position of the cursor can be set with mouse or right/left
cursor keys.

3.7 - Symbols Window

Symbols window displays global symbols available in the debugged application.
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Fig.22 - Symbols window

Fig.21 - Graph window



Format of the display can be changed with two options:

Display Address check box enables display of the numeric address value of the symbol.

Address First will control if the address of the symbol is displayed before or after the symbol name.
This controls sorting of the list entries.

Here are five operations, which can be performed on the selected symbol:

Watch adds the symbol to the Watch window

Dasm sets the starting address of the Code window

Display sets the starting address of the Memory window

Graph Set the starting address of the graph window

Break inserts software breakpoint at the symbol address

Goto inserts temporary breakpoint at symbols address and starts execution

Displayed symbols can be also filtered with two optional filters:

Symbol will select all the names matching control string. * character is a wild
character matching any number of any characters.

Address will display symbols, which address is within the specified range. Starting
address can be in two formats: with and without memory space prefix. No
space prefix will allow all memory spaces to match address range.

3.8 - Trace Window

Trace window shows last instructions executed by the target DSP. The trace buffer holds last six
addresses. The address is followed by the disassembly of the code at this address location.
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Fig.23 - Trace window



3.9 - Watch window

Watch window allows to display selected symbolic items or expressions. Items can be added to the
watch window with the WATCH command, or by pressing the Watch button within the Symbols

window. To delete item from the watch window, you can press the Del key on the keyboard, when the
cursor is over the line to be deleted, or with the WATCH command.

If the watch contains element which can be expanded (array, structure, union, etc.) the + will be
displayed in front of the symbol name. Expanded symbols will have - character, indicating, that the
item can be collapsed.

The watch line properties can be edited through the dialog available with the right-mouse button.
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Fig.24 - Watch window with sample data



3.10 - Open connection dialog

Open Connection dialog allows to select the target for the BoxView operation.. Primary item to be
selected is the Interface Type.

Connection type can be Direct or Remote over the TCP/IP network (optional BoxServer application is
required).

For the direct connection, depending on the interface type, proper port needs to be selected. It can be
one of the COM ports, one of the printer ports, or base address for the ISA interface card.

For TCP/IP connection only required parameters are the address of the server, and port # of the IP
server to be connected to. To inquiry the server about the target availability, use the Query button.
After query is completed, list of the available target devices will be displayed in the Target Select list.

The Initialize on start check box, if checked, will cause auto target initialization, on next BoxView
invocation.
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Fig.25 - Open connection dialog



3.11 - Startup Options

This dialog is available from the main pull down menu: Options --> Startup.
The options checked within this dialog, control the program action during its invocation:

• Open connection - will initialize the connection to the target, as it was last specified by the
Open Connection dialog.

• Load symbols - will reload the last used symbol table. This option is disabled if the open
connection is not active.

• Load breakpoints - will reload software breakpoint table. The breakpoint table is saved
during program termination, just before clearing all software breakpoints on program exit.
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Fig. 26 - Startup Options



3.12 - Load File Dialog

Load File dialog provides options necessary for uploading the code to the target DSP. Selection of the
file is available with the File button. This will invoke standard Windows file browser dialog. Main
check-boxes are: Load Data and Load Symbols. Disabling of data loading can be useful for
debugging applications, which are loaded to the DSP through another interface.

For the code loaded from the .s19 files, target memory option needs to be specified. The .s19 format
does not contain the memory space information, so memory can be defined with P, X oor Y
radio-button selection. The Auto mode performs load with the following algorithm:

• fileName.s19 is loaded to P memory space

• fileName_1.s19 is loaded to X memory space

• fileName_2.s19 is loaded to Y memory space

Execute command before load check-box, enables editable field, where user can specify the
commands required to enable access to the DSP memory, or set any initial conditions.

Execute command after load can be used to initialize certain variables, set breakpoints and start
execution.
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3.13 - Hardware Breakpoints

Hardwre breakpoints are controlled throgh the dialog. Dialog is available throgh the main pull-down
menu: Breakpoints --> Hardware break.

Dialog follow the features available on the emulation circuitry for the specific DSP processor.

ST18950 provides four address/value comparators with additional control logic. Every brekpoint
register BP0..BP3 allows for specification of the 16-bit value, which can be compared for: equal,
greater or equal, less or equal and not equal conditions. Grouping registers BP0 and BP1 or BP2 and
BP3 allows for specification of the range trigerring. First pair allows for breaking on events related to
the address bus for X or Y memory. Second pair controls program address execution and/or data bus
contents for X and Y memory spaces.

Software breakpoints require one of the program address brekpoints (BP2 or BP3) for its operation. If
any software breakpoints are active, one of the hardware breakpoints will be disabled for the user
access, so it can be used for the software breakpoint control.

Any of the four breakpints can have enabled counter option. If the counter option is enabled, the target
DSP will be halted, when the counter reaches zero.

Breakpoints can have command associated with its occurance. Every time the breakpoint condition
occurs, the soecified command or macro will be executed.
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The trap option will cause the refresh of the debugger windows, execution of the specified command,
and resume target code - run the DSP.

3.14 - Software Breakpoints

Software breakpoints can be set in the following ways:

• BREAK command

• By selecting the symbol and option Break within the symbols dialog

• By double-clicking on the code line, or with the function key F7.

The action of the mouse-click or function key can be modified by pressing the Shift or Ctrl keys:

• Ctrl key - toggles the �show� attribute. The breakpoint with the �show & go� attribute will
cause the code execution to continue, after updating the DSP resource windows.

• Shift key - will toggle the disable attribute. Disabled breakpoint is removed from the
memory, but it is still present in the symbol table for future use.

List of the breakpoints and attributes associated with every breakpoint, can be controlled from the
Breakpoint Dialog (main pull-down menu: Breakpoint-->Display).
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Fig. 29 - Software Breakpoints



The three buttons allow for following action:

• Dasm - will set the address of the code window, to display the code at the breakpoint
address.

• Add - allows to specify new breakpoint address

• Delete - will clear the breakpoint and remove it from the list

The check boxes allow for direct control of every breakpoint attributes:

• Show & Go - causes redisplay of memory, graph and register windows, and continuation of
the DSP execution

• Disable - removes brekpoint from memory

• Execute - will execute spcified command or macro

• Test - will invoke expression evaluator. If the expression evaluates to non zero (TRUE),
execution of the DSP code will be terminated, otherwise it will continue.

3.15 - User Buttons

BoxView allows for customization of the toolbar with user buttons. Addition of the button is provided
with the dialog available at the main pull-down menu (Options->User Buttons).

The dialogs allows for filling three fields:

Button Text: this text will be streched to the button size, and displayed on top of it. The text can be
between 1 and 4 characters long.

Quick Help: represents the text, which will be displayed, whenmouse pointer is hold over the button.

Execute: represents the actual command or macro command name to be executed, when the button
is pressed.
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Fig. 30 - User Buttons Dialog



When the mouse pointer is hold over the button,the quick help text will be displayed. The contents of
the help text is user configurable.

Every button can be changed or removed with the local menu available with the right-mouse button.
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Fig. 34 - User Button local dialog

Fig. 31 - User Button with help



CHAPTER 4 - BoxView Commands

4.1 The command interpreter

The command interpreter is a recursive function which parses and executes commands entered at the
keyboard, command files, macros and trap / breakpoint commands. It is an infinite loop that executes
the following steps:

1. Reads a line from the input.

2. Breaks a read string into words using a sequence of one or more of blanks,
tabs, or commas as separators. Characters enclosed between double
quotes are treated as a single word (this is only used in the PRINT
command).

3. Replaces each occurrence of the symbol "@n" with the actual value of that
argument [DO] if the input source is a macro.

4. Scans each word and string that is enclosed in reverse quotes "� " and treats
it as an expression.

5. Evaluates the expression and substitutes the result (printed as one to four
hexadecimal digit characters) in the expression string. Each time a new
input source is set up, the command interpreter is recursively called to read
the new source up to the end. If the specified command does not match any
of the debugger commands the new command file is opened
automatically.The debugger starts the input from a command file, the file is
read until the end of the file is reached.

The DO command starts the input from a macro body, the macro is read up to the end of body.

Macros, command files, and trap commands can be nested up to 20 levels.

The IF/ELSE/ENDIF commands select a group of commands to execute without changing the input
source and without affecting the level count. The command interpreter ends when the ELSE or the
ENDIF command is found.

Ending the top level (standard input reading) command interpreter, terminates the emulator program
(after a confirmation request).

During their execution, some commands (ASM, SM, etc...) require more input to be read. This input is
taken from the same source from which the command was read.

Lines beginning with a colon character are ignored and can be used for programmer�s comments.
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The following key sequences are defined in keyboard input mode:

up and down arrows retrieves previous commands

ESC clears the input line

Ins switches between insert and overtype

Del erases the current character

Commands and arguments are not case sensitive except in some particular cases which will be noted
where applicable.

4.2 Command line expressions

Command line expressions contain one or more terms. Each term can be preceded by an unary
operator, and separated by binary operators. Expressions must be single words and, therefore,
cannot contain spaces.The syntax and semantics of expressions are very close to those of C
language.

When an expression must be interpreted as a number, either to be used as a memory address, a
register, or a value, the expression is sent to the expression evaluator. The expression evaluator
returns the numeric value of the expression. Intermediate results are stored as 32 bit unsigned
integers. The final result can be truncated to the lowest 8 or 16 bits as required.

4.2.1 Expression terms

In the following definitions:

• lowercase words are generic names

• uppercase words are keywords which can be in uppercase or lowercase inside the
expression
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Definition of terms used in expressions:

Term Definition

number A sequence of one or more hexadecimal, decimal or octal digits, depending
on the current base selected [BASE]. It can be prefixed with '0x' to force it to
be interpreted as a hexadecimal number.

�character� A character enclosed between single quotes is evaluated as its ASCII value
(so that 'A' is equivalent to the hexadecimal value 41).

$symbol A legal symbol name, preceded by the dollar sign '$'. The value is the symbol
value.

(expr) An expression enclosed between parenthesis is a single term and the value
is the value of the expression. It can be used to change the order of the
evaluation of the expression terms.

Mterm
MMterm The value is the content of the memory (first case) at address term, or the

content of the concatenation (second case) of the 2 memory data at term.

#term The value read from channel term [OPEN]

R$symbol The value is the content of the register

4.2.2 Unary operators

The unary operators group right to left are defined as follows:

Definition of unary operators:

Operator Description

! !term is evaluated as 1 if term has value 0, 0 otherwise.

~ ~term is the bitwise negation of term, i.e ~0x55 is equal to FFFFFFAA.
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4.2.3 Binary operators

All binary operators group left to right except the assignment operator which groups right to left. In
decreasing order of precedence, the binary operators are:

Definition of binary operators

Operator Description

* / % Multiplication, division and modulo (remainder).

+ - Addition and subtraction.

>> << Logical right and left shift, i.e. 0xC>>2 is equal to 3.

== != Logical equality and inequality, evaluated as 1 if true and 0 if false, i.e.
5==3+2 is equal to 1 and 5!=3+2 is equal to 0.

> >= < <= Logical comparison for greater, greater or equal, less, less or equal,
evaluated to 1 if true and 0 if false.

& Bitwise AND.

^ Bitwise EXCLUSIVE OR.

| Bitwise OR.

= Assignment operator. The left operand can be only an M, MM or #term. The
right operand can be an M, MM, #term or the result of an expression
evaluation.

4.3 Programming the emulator with the command line interface

4.3.1 Defining macro commands

Macro commands can be defined to carry out a sequence of individual emulator commands. The
watchdata or action in breakpoint commands can be used to run a program starting from address 100,
and see the value of the memory at address 50 when the program reaches the address 110.
Alternatively a macro command can be written.
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1. To define a macro, use the de -m command (ref.�DEFINE� ):

de -m run_and_see

sr PC 100

sb 110

go

: display memory at address 50

dm 50

endm

The first line defines themacro name "run_and_see"; the last line indicates ends themacro command.
Line 5 begins with a colon and is not read.

2. To run a previously defined macro, use the do command (ref.�DO�):

do run_and_see

3. To define the samemacro with the possibility of defining the address at each
execu-tion, specify parameter "@ 1" in the macro definition:

de -m -f run_and_see

sr PC 100

sb 110

go

dm @1

endm

4. To execute this macro, type:

do run_and_see 40

The macro will be executed as before, replacing parameter @1 by its
specified value: 40.

5. To list the macro commands, use command li (ref.�LISTSYMBOL�):

li -m run_and_see

6. To store your macros in a file on disk, use the command ar (ref.�ARCHIVE�):

ar -p -m file.mac

This command stores themacro in the file named "file.mac". This is an ASCII
file which can be modified with any editor.

7. To retrieve the macro from file, type:

ar -g -m file.mac
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4.3.2 Programming

Variables and programming statements can be included in a macro-commands. For full details on
programming inside macros, (ref. FOR, IF, JUMP ).

Up to 30 variables can be user defined from "v0" to "v1d" hexadecimal address. These variables can
be set, tested, or used in programming statements.

Expressions must not contain spaces. For example, the line:

v0 = 0

is incorrect.

Using the same macro as above:

1. To run the program 10 times and see the following byte each time, use the
define command (ref.�DEFINE� ):

de -m -f run_and_see

sr PC 100

sb 110

for v0 1 A 1

go

dm @1+v0

endfor

endm

When typing:

do run_and_see 40

the commands between FOR and ENDFORwill be executed 10 times (i.e. A
times in hexadecimal, note that parameters are in current base). Command
"dm @1+v0" will be interpreted as "dm 40+1", then "dm 40+2", and so on.

38 BoxView User Manual

Commands

4



2. To execute out a test program:

de -m -f run_and see

reset

sb 110

v0=1

.loop

go

dm @1+v0

v0=v0+1

if (v0<=A) jump loop

endm

3. To define a label use the de command ( ref. �DEFINE� ).

4. To jump to a label use the jump command (ref. �JUMP� ).

4.3.3 Memory and register access

To display thememory location in hexadecimal format and thememory value in decimal format, define
a macro as follows:

de -m -f run_and_see

sr PC 100

sb 110

for v0 1 A 1

go

print -n -f "%x = " @1+v0

print -f "%d" m(@1+v0)

endfor

endm

In this macro, the syntax "m(@1+v0)" requests the memory value at address
(@1+v0).
The PRINT command gives a formatted display.

1. To obtain the data in P memory at address 10, type or use in a macro:

v0=m10

2. To obtain the data in X memory at address 10, type or use in a macro:

v0=mx:10
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3. To obtain the double data in memory at address 10 and 11, type or use in a
macro:

if (m10<=m11)

The test will be true if data in P memory at address 10 is lower or equal to
data in memory at address 11.

v0=m(mm10) v0 will contain the data in memory which address is contained in
double data at address 10 and 11: this expression is an indirect
access to the memory.

v0=mm(m10) v0 contains the word in memory whose address is contained in
data in memory at address 10.

v0=mmm10 will be interpreted as: v0=mm(m10).

The above examples use absolute addresses, but symbolic names can be used instead.
The character �$� means a symbol name.

print m$

if (v0 == m$) ...

Symbols can be used for register addresses:

v0=r$a1h

v0 will contain the value of the register A1H.

You can write expressions such as:

if (r$pc==mm100) jump end

Memory and register access syntax is explained in full in the PRINT command description.

4.4 File management

Channels are used to store the results of programs. In the D950 emulator, the channel feature is
similar to file management in C or other high-level language: channels can opened, read from, written
to and closed.

Channels may be opened as input or output, but not both; they can contain ASCII or binary values. All
values must have the same length, for example, to read a different memory address at each step of
the previous debugging program, and store the content of X-spacememory in a file. Channel syntax is
explained in full in the OPEN and CLOSE command description. (Ref. �OPEN� and �CLOSE� ).
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See the following example:

1. Edit a file called "address", containing the addresses to check.

Since addresses are 16-bits long, use a file that contains 16-bits long values.
In ASCII mode, each value must be separated by spaces, tab or end of line.
Suppose the "address" file is:

0000 0100 0105 0107 0168 00a4 0078 0123 0150 0120

2. To open the file "address" for reading, giving it the channel number 1,
reading each time 2 bytes, type:

open 1 address input ascii 2

Output values are stored in a binary file "result", in which each value will be a
data.

3. To open file "result" for writing, giving it the channel number 2, writing each
time 2 bytes, type:

open 2 result output binary 2

4. To read and write from/to a channel, we use the character "#" followed by the
channel number. For example, "#1" means one value, read from or written to
the file associated ,to channel 1.

The macro becomes:

de -m test_auto

open 1 address input ascii 2

open 2 result output binary 2

for v0 1 A 1

go

v1=#1

#2=mx:v1

endfor

close 1

close 2

endm

Expression "v1=#1" writes to v1 the 16-bit value read in file "address"
(channel #1). Expression "#2=mx:v1" writes in the "result" file (channel #2)
the contents of the memory at location "v1" in the memory space X.

By running this macro and checking the contents of the file "result" versus a
reference version each time the program is changed, you have a
non-regression procedure to test program evolution.

5. To test for the end of file, open the file as input and use the @ command.
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4.5 General notes

The following notes describe the syntax and general concepts used in the description of commands.

1. Debugger�s commands can be typed in both lower and upper case letters,
arguments of commands must be separated by at least one space, tab or
comma.

2. The names of commands can be written in full or in abbreviated form: in the
commands descriptions, the maximum (i.e. the shortest) allowed
abbreviation is shown in upper case and the remaining part of the name is
shown in lower case.

3 The following syntax has been used:

The character "|" means "or".

An argument between square brackets is optional.

An argument followed by dots as in "value ... " means that the argument can
be specified more than once.

Braces "{" and "}" are used to group arguments that are treated as a single
construct.

4. Numeric values are interpreted and printed in the selected numeric base
(DECIMAL, OCTAL, or HEXADECIMAL). The current base selected is
indicated by the prompt letter at the beginning of each command line
"d:" "o:", or "x:" (ref.�BASE� ).
Some commands require and/or print value in decimal base only; this will be
explicitly indicated in the command description.

5. Iteration or long commands can be aborted by typing <ESC> key

6. The last command executed may be requested again by typing a dot
character

7. All previous commands can be recovered with the up and down arrows, and
modified using left and right arrows, <DEL>, <INS>, <Home>, <End>...

8. Error messages produced by the debugger are self-explanatory and indicate
the cause of the error.
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Syntax ADDR address

Menu View → Symbols

Description The ADDR command sets starting address for the last active CODEwindow.

address starting address value of the program to be displayed.

Syntax ALIAS [name[,"string�]]

Menu ---

Description The ALIAS command entered without any parameters will display all defined
aliases. If only the name is specified, system will display current definition of
the alias associated with this name.name alias name for the reference as the
system commandsstring command string referenced by the name. Multiple
commands in the alias definition need to be separated with the semicolon.
Command parameters can be specified with the percent sign and a number
(%1, %2, �). Previously defined alias names can be used in the new
command string.

Syntax ARCHIVE {-g|-p} {-a|-m} [-f] file

Menu ---

Description The ARCHIVE command loads into memory from a file or saves in a file the
symbol table of the specified type:

-a memory address type symbols

-m macros

-g (shorthand for "get"). Symbols and definitions found in file are loaded into
the symbol table. Unless the -f option is selected, symbols already defined in
the symbol table are not redefined and an error message is issued.
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-p (shorthand for "put"). Symbols of the given type and their definitions are
stored in the specified file. If the file already exists and option -f is not
selected, a confirmation is requested before overwriting the file.

Symbols of memory addresses are saved in files in alphabetical order, one
per line with their value in hexadecimal format.

Macros are saved in files as they are defined (that is literally)

See also DEFINE, DO, DISASM, LISTSYMBOL, UNDEFINE

Syntax ASM [address mnemonic]

Menu Local menu of the code window

Description The ASM command without parameter will change display mode of the last
selected Code window to assembly mode.

The ASM command with address and menonic string, will invoke the inline
assembler in the context of the specified address.

This command allows to write D950 instructions in C-like syntax in the
program memory at the specified address.

Example cmd>asm 100 jump begin

See also DISASM

Syntax BASE [x|o|d]

Menu ---

Description The BASE command may be used to select the base of numbers.

"x" selected hexadecimal numbers
"o" selected octal numbers
"d" decimal numbers
The base currently selected is indicated by the prompt symbol of the
debugger, according to the parameter of the BASE command.

Example Base d
Base x
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Synatx BEEP

Menu ---

Description This command activates system's default sound (configured through
"Sounds" in theWindows Panel)

Syntax BREAK [OFF] [address]

Menu Breakpoint → Display

Description The BREAK command sets the software breakpoint at the specific address.
If no parameters are specified, system will display all breakpoints set.OFF
will remove breakpoint at the specific address, or all breakpoints if the
address is omitted.

address absolute address or symbol

Synatx BYE

Menu ---

Description Exit application
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Synatx CALLS

Menu ---

Description The CALLS command displays current call stack in the command window.
This represents the information displayed also in the Calls window, but it will
allow to add this information ioto the log file. Call stack is build using the
information created by C programs. This is not available for the assembly
programs.

See also LOG.

Synatx CASCADE

Menu Window → Cascade

Description Arrange all opened windows in the cascade format.

Synatx CD

Menu ---

Description CD command allows to change or display debugger's current working
directory

pathname directory path to be changed or displayed
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Syntax CHANGE address | address range | register name value

Menu Direct resource editing

Description The CHANGE command allows to change contents of the memory range or
the register.

address memory

address to be changed in the format: space:offset, where space is one of the
allowed memory spaces for the processor (P, X, Y ), offset absolute value of
the address offset. Address can be also specified in the form of the
application symbol.

address range

specifies memory area to be changed to the value. Range can be accepted
in two formats:
start_address..end_address or start_address#count.

register name

refers to one of the valid DSP registers (A0L, SP, PC, etc.)

Synatx CLOSE channel

Menu ---

Description This command allows to close the channel specified.
channel must be a decimal number from 1 to 10.

Closing a channel that has not yet been opened does not cause an error.
Once closed a channel cannot be used for reading or writing data.

Example close 1

See also OPEN
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Synatx CLS

Menu ---

Description The CLS command clears the screen, and put cursor at the first line, first
column

Example CLS

See also @CURX, @CURY, LOCATE

Syntax CM addr1 addr2 [count]

Menu ---

Description The CM command allows to compare the content of count data of memory
at address addr1, with the content of memory at address addr2.

If count is not specified, it is assumed equal to 1.

For each comparison resulting in a difference, the addresses and the
contents of the corresponding memory cells are printed.

Example CM 10 100 20
CM x:10 x:100 20

See also DM, FM, SM

Syntax CODEMENU text [command|r]

Menu ---

Description CODEMENU command allows to add or remove custom commands to/from
the CODE window's local menu (available with right-mouse click).
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CM Compare memory values

CODEMENU Add/remove entry to Code window menu

CLS Clear screen



Syntax COLOR window_id value

Menu ---

Description The COLOR command allows to change default colors in the specific
window. Parameter winName represents the window name, as it appears in
its title. ColorId is the number for the color type to change. There are different
numbers of colors for different windows. This information is displayed in the
colors setup dialog (Options-->Colors). The value is a hexadecimal value
representing the background (high nibble) and foreground (low nibble). The
color association with color values 0..15 can be seen in the Color Setup
dialog. The default for value 0xf (15) is white, default for value of 0 is black,
but any color can be changed with above dialog.

Example Color memory 1 f2

Syntax COMPARE addr1 addr2 [count]

Menu ---

Description The CM command allows to compare the content of count data of memory at
address addr1, with the content of memory at address addr2.

If count is not specified, it is assumed equal to 1.

For each comparison resulting in a difference, the addresses and the
contents of the corresponding memory cells are printed.

Example: CM 10 100 20
CM x:10 x:100 20

See also: DM, FM, SM
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COMPARE Compare memory values

COLOR Change window color



S

yntax CONNECT [interface type[,device[,[IpAddr][,port]]]]

Menu Options → Open Connection

Description The CONNECT command initializes connection to the target processor.
Parameters specify details of the connection. interface type can be one of
the following:EmuSt950ISA, EmuSt950PP or EmuSt950Test. Device
indicates device # in the scan chain to connect to. This is required for the
multi processor systems.
IpAddr defines TCP/IP address for the remote connection to the server.
For the local connection this parameter needs to be empty.port indicates
physical address of the target to be connected to. In case of the remote
connection to the IpAddr this is server�s port number (by default 5417 is
used).
For the local printer port connection this is the LPT port number (1, 2,�). For
the local I/O port interface, this is the I/O port base address (240, 340, �).

Syntax COPY address_range mem_address

Menu ---

Description The COPY command allows the user to execute a fast copy of the memory
block specified by the address_range to another location specified by
mem_address.
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COPY Copy memory block

CONNECT Initialize hardware interface



Syntax @CURX

@CURY

Menu ---

Description The @CURX and @CURY commands are variables that return the current
cursor position. CURX returns the current column value, and CURY returns
the current line value.

Example CM 10 100 20
CM x:10 x:100 20V0=@CURX
print @cury

See also CLS, LOCATE

Syntax DASM [address]

Menu ---

Description The DASM command will set starting address of the Code window to the
address value. If no parameter is specified, command will cause to scroll
Code window one page down. Command affects only the last selected Code
window, other Code windows are not affected.

Syntax DEFINE -a [-f] symbol [space:] value
DEFINE -m [-f] symbol

...

ENDM

Menu ---

Description In the first case, symbol refers to a memory address. Symbol and value

must be a valid address.The second case is used to define the macro called
symbol. A macro is a collection of commands that can be put into execution
via the DO command. The lines following the DEFINE command are read up
to a line containing the keyword ENDM and form the macro body.
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Notice that macro body is stored in memory literally, without any
interpretation, except that leading blanks are stripped, and lines beginning
with the colon character (:) are discarded.
Macro parameters can be embedded in macro body as "@n", where n is a
single digit between 0 and 7. They will be expanded at macro execution time
with the literal value of the actual parameters passed to the macro.

• symbol can be any word composed of letters, numbers, "_" (underscore),
"$" characters. However, the first character can be a "." (period) but cannot
be a digit.

• Symbols are case sensitive.

• Symbols can be of any length, but only its first 8 characters are considered
meaningful.

• Unless the -f (shorthand for "force") option is specified, if the symbol is
already defined, an error message is issued and the definition of the symbol
is not changed.

• If two address symbols have the same value, the most recently defined one
will be used when the symbol table will be searched for a value.

• Symbols are stored in memory for fast retrieval and alphabetical sorting.
Each symbol requires memory that is allocated when the symbol is defined
and released when the symbol is removed. Defining more symbols than
allowed by the available memory will cause an "OUT OF MEMORY" error
message.

• Address symbols may be used in any expression by writing them preceded
by the dollar operator ("$"). This operator will cause the symbol to be
replaced by its numeric value.

Example define -a lab x:10
define -m LOADANDGO
reset
print "LOADING FILE @1"
load @1
sb on @2
go
endm

A macro, once defined, may be invoked using the DO command. About the
ex-ample illustrated above, the LOADANDGOmacro could be executed like
this: do LOADANDGO prog_8 1234

Then a DSP reset will be done, prog_8 loaded, run and finally stopped if
ad-dress 1234 is reached.

See also ARCHIVE, DISASM, DO, LISTSYMBOL, UNDEFINE.
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Syntax DISASM addr [count] or DI addr [count]

Menu ---

Description The DISASM command allows to display the content of memory at address
addr, in symbolic format, i.e., in mnemonic assembler code.

See also ASM

Syntax DIR [directory name]

Menu ---

Description The DIR command displays a directory listing in the display area of the
COMMAND window. If you use the optional [directory name] parameter, the
debugger displays a list of the specified directory's contents. If you do not
use the parameter, the debugger lists the contents of the current directory.

Syntax DISASM addr [count]

Menu ---

Description The DISASM command allows to display the content of memory at address
addr , in symbolic format, i.e., in mnemonic assembler code.

See also ASM
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DISASM Display memory in mnemonic format

DIR Display directory contents

DI Disassemble memory



Syntax DISCONNECT

Menu Options → Close connection

Description Close hardware Interface.
The DISCONNECT command will disable connection with the target
processor. This allows to select another processor to be accessed (in case
of the multiprocessor or remote access).

Syntax DISPLAY [address]

Menu View → Symbols dialog

Description The DISPLAY command will set starting address of the Memory window to
the address value. Address should have the following format: space:offset,
where space is one of the allowed memory spaces for the processor (P, X,
Y), offset absolute value of the address offset. Address can be also specified
in the form of the application symbol. If no parameter is specified, command
will cause to scroll Memory window one page down Command affects only
the last selectedMemory window, other Memory windows are not affected.

Synatx DM addr

DM from to

Menu ---

Description The DM command allows to display the memory content on a word basis.

In the first case, the command displays the content of memory at address
addr.

In the second case, the command displays the content of the memory block
enclosed between addresses from and to (included). Memory content is
displayed both in numeric notation and in ASCII code.

Example DM 0 50
DM x:10 20

See also CM, FM, SM
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DM Display memory

DISPLAY Set memory address or Scroll Page Down Memory window

DISCONNECT Close connection to the target processor



Syntax DO macro_name [actual_parameters_list]

Menu ---

Description The DO command executes the macro macro_name with the specified
parameters. The macro body is read by the command interpreter and
commands executed as if read from the keyboard.

Interactive commands, like ASM, take their input from the lines following the
command in themacro body. They also work silently, i.e., they do not display
any prompt.
Before a line is read from macro body, any instance of "@n", where n is a
single digit between 0 and 7, is substituted with the corresponding
parameter taken from the parameter list.
"@0" is the macro name itself, "@1" is the first parameter, and so on. Up to 7
parameters can be given in the parameter list. Parameters not defined are
substituted with a null string.

Macro executions can be nested. Execution can be interrupted with <Esc>
key.

Example define -m LOADANDGO
reset
print "LOADING FILE @1"
load @1
sb on @2
go
endm
do LOADANDGO prog_8 1234

See also DEFINE, LISTSYMBOL, QUIT, UNDEFINE
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DO Execute macro command



Syntax DR
DR reg-name

DR reg-1 reg-2

Menu ---

Description The DR command displays the content of registers.

• Used without argument, it displays all DSP registers

• If a single register is specified, only that register will be displayed.

• In the last form, the registers between reg-1 and reg-2 (included) are
displayed, one per line. Register order is:

• AX0, AX1 X address registers

• AY0, AY1 Y address registers

• IX0, IX1, IX2, IX3X index registers

• IY0, IY1, IY2, IY3Y index registers

• SP, SPY Stack pointers

• LS, LC, LE Loop start/count/end registers

• L0, L1, R0, R1 DCU input registers

• PL, PH Product registers LSB/MSB

• CCR Condition code register

• DCU0CR, STA Status registers

• A0L, A0H, A0E Accumulator 0 LSB/MSB/Ext

• BSC Barrel shifter control register

• A1L, A1H, A1E Accumulator 1 LSB/MSB/Ext

• PSC Product shift control register

• PC Program counter

Example DR
DR A0H
DR IX0 IX3

See also SR
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DR Display/set registers



Syntax DEFINE -a [-f] symbol address

DEFINE -m [-f] symbol

...

...

ENDM

Menu ---

Description In the first case, defined symbol will allow references to the given
address.The second case is used to define the macro called symbol. A
macro is a collection of commands that can be put into execution via the DO
command. The lines following the DEFINE command are read up to a line
containing the keyword ENDM and form the macro body.

Notice that macro body is stored in memory literally, without any
interpretation, except that leading blanks are stripped, and lines beginning
with the colon character (:) are discarded. Macro parameters can be
embedded in macro body as "@<n>", where <n> is a single digit between 0
and 7. They will be expanded at macro execution time with the literal value of
the actual parameters passed to the macro.

Unless the -f (shorthand for "force") option is specified, if the symbol is
already defined, an error message is issued and the definition of the symbol
is not changed.If two address symbols have the same value, the most
recently defined one will be used when the symbol table will be searched for
a value.

Symbols are stored in memory for fast retrieval and alphabetical sorting.
Each symbol requires memory that is allocated when the symbol is defined
and released when the symbol is removed. Defining more symbols than
allowed by the available memory will cause an "OUT OF MEMORY" error
message.

Address symbols may be used in any expression by writing them preceded
by the dollar operator ("$"). This operator will cause the symbol to be
replaced by its numeric value.

Example define -a lab x:10
define -m LOADANDGO
reset
print "LOADING FILE @1"load @1
sb on @2
go
endm
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ENDM End of macro definition



A macro, once defined, may be invoked using the DO command. About the
example illustrated above, the LOADANDGO macro could be executed like
this: do LOADANDGO prog_8 1234

Then a DSP reset will be done, prog_8 loaded, run and finally stopped if
address 1234 is reached.

Syntax EVAL rval=lval addr2 [count]

Menu ---

Description This command allows to evaluate any �C type� expression. The evaluation
result is stored into the �lval� destination. Destination can be any register,
memory location or system variable (v0..v1d). To display the result of the
evaluation, �?� command needs to be used.

Example EVAL IX0 = *ptr + 4

Syntax ? [lval= ] rval

Menu ---

Description This command displays the result from the expression evaluator. This is
identical to the EVAL command, but it also displays the result in the
command window. The expressions supported are any C-type expression
string.

Example ? AX0+AX1
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EVAL Evaluate expression

? Evaluate expression and print results



Syntax EXEIO

Menu ---

Description Command initializes data transfer to/from the DSP. Parameters of the data
transfer are passed within global variables v20..v23. Result of the data
transfer is returned in the variable v24. If transfer fails, variable is set to
non-zero value.

Global variables definition:

v20 transfer starting address within the DSP memory

v21 number of words to transfer

v22 direction (0x8000 - write, 0x4000 - read) and memory space
(0 - PMEM, 1 - XMEM, 2 - YMEM)

v23 file # to use

v24 error flag set by transfer routine

See also: INPUT, OUTPUT

Syntax IF @EOF (channel#) JUMP label

Menu ---

Description The @EOF command tests if the end of a file opened when the input
channel has been reached.

The function returns FALSE if the end of a file has not been reached,
otherwise it returns TRUE. The function works like the C-language function,
meaning that it returns TRUE when the program has tried to read after the
end of the file; in this case, the value read is undefined.

Example de -m test
open 1 @1 input ascii 2
.loop
v1=#1
if @EOF(1) jump endfile
print v1
jump loop
.endfile
print "end of file encountered"
close 1
endm
do test datas.2 See also OPEN, CLOSE
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@EOF Test end of input channel

EXEIO Initializes data transfer



Syntax FILL from to pattern

Menu ---

Description Fill the memory block indicated by the limit address <from> and <to> with the
values indicated in pattern

Up to 8 values can be indicated. They will be repeatedly put in the memory in
the same order until the block is filled.

Example FM x:100 200 1234 5678

See also CM, DM, SM

Syntax FM [space:] from to pattern

Menu ---

Description The FM command fills the memory block indicated by the limit addresses
from and to with the values indicated in pattern

Up to 8 values can be indicated. They will be repeatedly put in the memory in
the same order until the block is filled.

Example FM x:100 200 1234 5678

See also CM, DM, SM

Syntax FOCUS winName|forward|reverse

Menu ---

Description FOCUS command allows to change active window within debugger
interface. If the window name is specified, it will activate first window of the
specified type. For forward/reverse parameters windows will be activated in
the round robin order. Command can be assigned to the function key or
button with the ALIAS command.
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FM Fill memory with a pattern

FOCUS Bring window to front

FILL Fill memory with a pattern



Syntax FOR var start end [step]

...

...

ENDFOR

Menu ---

Description The FOR command loops from start value to end value in increments of
step. The parameter var must be a valid variable (v0 to v1d).

Default value for increment is 1.

Example : Set memory between 10 and 20 to zero
FOR v0 10 20
sm v0 0
ENDFOR

Syntax FORCE Break/Reset

Menu ---

Description The FORCE command allows to stop execution of the program (Break
parameter), or reset the target processor (Reset parameter).

Example : Force r

Syntax FUNCTION name|address

Menu ---

Description FUNCTION command displays specified function in the code window in the
SOURCE mode.
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FORCE Reset or halt target

FUNCTION Display function in Code window

FOR Loop command execution



Syntax GO [address]

Menu Process → GO, F5

Description The GO command executes code up to a specific address. If the address is
not supplied, code will execute until it reaches one of the breakpoints, or it is
stopped with the HALT command.

Syntax GOCURSOR

Menu F7

Description GOCURSOR command is available only for macro command processor and
custom menus of the code window. When invoked, it will set a temporary
breakpoint at the current position of the cursor within the code window. If the
current position of the cursor cannot be translated to the address value,
command will have no effect. This command can be also assigned to the
function keys with the ALIAS command.

Syntax GRAPH [mem_address]

Menu ---

Description The GRAPH command will set the starting address of the Graph window to
the mem_address value. If no parameter is specified, the command will
cause the Graph window to scroll one page down. This command affects
only the last selected Graph window; other Graph windows are not affected.
If there is no Graph window opened, the command will open a new window
in the graph format.
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GRAPH Set/PgDn graph memory window address

GOCURSOR Execute code to cursor within code window

GO Start executing target code up to address



Syntax HALT

Menu Process → HALT, Shift-F5

Description The HALT command will enter the target processor into the debug mode,
allowing to access target resources.

Syntax HELP [keyword]

Menu Help, F1

Description The HELP command will invoke help file associated with the debugger
application. If keyword is one of the valid topics, it will be automatically
displayed.

Syntax IDCODE

Menu ---

Description The IDCODE command will read and display IDCODE of the target
processor. IDCODE is a 32 bit number representing manufacturer,
processor type and version.
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IDCODE Read JTAG IDCODE

HELP Get help on a specific item

HALT Halt target processor



Syntax IF expr command

IF expr

...

[ELSE]

...

ENDIF

Menu ---

Description The IF command conditionally executes one or more other commands,
depending on the value of expr. If value of expr is not zero, then:

• in the first case the single following command is executed.

• in the second case all following commands up to ELSE or ENDIF are
executed.

If value of expression is zero and ELSE is present, then only the commands
between ELSE and ENDIF are executed.

IF commands can be nested up to 10 levels. Nesting more than 10 IFs will
re-sult in an error message.

If the command is read from the keyboard, the prompt displays the current
nesting level by adding one colon for each level. Hitting <END> will result in
an exit from all nesting.

Example de -m -f run_and_see
reset
sb 110
v0=1
.loop
go
dm @1+v0
v0=v0+1
if (v0<=A) jump loop
endm
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IF Conditional operator



Syntax INPUT [#(file_number)] OFF | TERM | filename [-dec | -hex | -bin [-cnt]]

Menu ---

Description The INPUT command is used to open a text or binary file and use the file to
pass data to the target DSP chip. The data is passed to the target DSP when
the user's program reaches a software breakpoint. The file lists the data
sequentially.

The INPUT command with no parameters displays all open input files.

# file_number is the number of the file opened (multiple files can be opened
simultaneously). The file number is optional, the range is 1 to 99. OFF closes
an opened input file. If a file is not specified, all opened files are closed.

TERM uses the terminal/keyboard (instead of a text file) to input data to the
target DSP.

filename is the name of the file used for data input.

dec specifies decimal ASCII data representation

hex specifies hexadecimal ASCII data representation. This is the default.

bin specifies binary data representation

cnt specifies number of bytes to read per each target word. It applies only to the
binary format.

The transfer of the data is invoked from the debugger by the EXEIO
command. This command expects transfer parameters to be stored in the
glabal variables: v20..v24.
To automate data transfer, user needs to set a breakpoint within the DSP
code, and specify "execute" and "test" options for this breakpoint. Command
file, invoked with the breakpoint's "execute" option, will initialize global
variables, and invoke debugger transfer routine with the EXEIO command.
The breakpoint's "test" option will evaluate result of the data transfer, and if it
was successful, it will restart the DSP. Global variables can be initialized
using variables/registers from the user program, or setup by the user
command file.

Global variables definition:

v20 transfer starting address within the DSP memory

v21 number of words to transfer

v22 direction (0x8000 - write, 0x4000 - read) and memory space
(0 - PMEM, 1 - XMEM, 2 - YMEM)

v23 file # to use

v24 error flag set by transfer routine

BoxView User Manual 65

Commands

4

INPUT Open the file and pass data to the target



Details on the INPUT data file in text formats

The text file is always ASCII, with the data listed sequentially. BoxView
provides ways to simplify the file editing. For example, if one word must be
send to the DSP repeatedly, you can have a repeat code instead of typing an
infinitely long file.

The following are the codes that may be used in the ASCII file:

# specifies the number of times a data word is repeated.

() parenthesis are used to group words. If parenthesis are preceded by # the
whole group is repeated. If # doest not precede the parenthesis, the group
of words is repeated indefinitely.

Example 1: 1 2 3 4
Send data words 1, 2, 3, 4.

Example 2: 121#10
Send the data word 121 10 times.

Example 3: (0 121)#10
Send 0, 121, 1, 121 ....

Example 4: (7fff)a
Send 7fff indefinitely

Example 5: 1 2 3 5#2 (10 20)#3 (10)
send 1, 2, 3, 5, 5, 10, 20, 10, 20, 10, 20, 10, 10,
10, 10, ...

Examples on entering the input command

Example 1: Display all currently open input files.

INPUT

Example 2: Open �DATA.IN� file, label it file number 1. Data in �DATA.IO� is in decimal.

INPUT #1 DATA.IO -dec

Example 3: Open DATA3.BIN file, label the file automatically. Data in DATA3.BIN is in
binary format, read one byte per DSP word

INPUT DATA3.BIN -b -1

Example 4: Read data from the terminal (keyboard) and send it to the DSP.

INPUT TERM
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Example of the command file initializing gloabal variables and

breakpooint for INPUT transfer:

INPUT off ;switch off old input streams

INPUT data_1 ;this will open an input file

BREAK p:110 xset_in tv24!=0 ;set a breakpoint, execute transfer,
;run target

eval v20=0x1040 ;start address to load

eval v21=0x10 ;read 16 words at a time

eval v22=0x8002 ;write to YMEM

eval v23=1 ;read from file #1

eval v24=0 ;error flag set if transfer fails

Example of the command executed, when the breakpoint at address

p:110 is reached:

exeio ;execute transfer

eval v20+=v2 ;increment destination address

break disable ;disable breakpoints

step ;step over the breakpoint

break enable ;reenable the breakpoints

See also EXEIO, OUTPUT

Syntax JUMP [condition] label

Menu ---

Description The JUMP command programs execution. It continues at the specified label
if the condition is true (!= 0). If no condition is specified, then it realizes an
unconditional jump.
Labels can be defined in a command file. They must start with a point (.) and
can be up to 80 characters long. A label MUST be the only entry on a line.

Example JUMP display_regs
JUMP m(0)==2 error_label
.display_regs
.error_label
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Syntax LINE [line_number] [file]

Menu ---

Description The LINE command displays lines: line_number-4, ... to line_number+6, of
the source file . By default, if line_number is not specified then it takes the
current PC, and if file is is not specified, takes the current loaded.

Example Line 10

See also ADDR

Syntax LISTSYMBOL {-a[space] | -m}

LISTSYMBOL {-a[space] | -m} pattern

Menu ---

Description The LISTSYMBOL command lists all the symbols of the given type (address
or macro) in alphabetical order along with their definition (value). To list
symbols in a specific memory space, specify the memory space as "x:", "y:"
or "p:"

The expression pattern is built with normal symbol names and characters:

"*" matches any sequence of characters;

"?" matches any characters.

Example li -a (displays X, Y and P space symbols)
li -ax: (displays X space symbols)
li -ax: lab (displays X space symbol "lab")li -m
(displays macros)
li -a:p _str* (displays P space symbols _str...)
li -a:x _std?? (displays P space symbols _stdin ...)

See also ARCHIVE, DEFINE, UNDEFINE.
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LISTSYMBOL Display symbols and macros

LINE Display assembler source line



Syntax LOAD filename [P/X/Y]

Menu File → Load

Description The LOAD command loads an object file to the target processor and its
associated symbol table into memory. The LOAD command is equivalent to
the RELOAD and SLOAD commands. If the filename has no extension,
system will add automatically the .cld extension. The LOAD command
clears the old symbol table.
For .S19 type files memory space can be specified ( default P space ).

Syntax LOCATE line column

Menu

Description The LOCATE command positions the cursor.
line must be in the range 1 to 25 and column must be in the range 1 to 80.

Example locate 3 15

Syntax LOG [OFF | filename]

Menu ---

Description Log command allows to open or close the log file. All output to the terminal
window is automatically saved into the log file.
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LOAD Load program and symbols

LOCATE Set cursor position

LOG Open/Close session log file



Syntax MAP [{ON|OFF} |{addr_block, type|-r}]

Menu ---

Description The MAP command sets mapping for memory address ranges. Enabling
mapping option, will enable READ and/or WRITE accesses to selected
memory areas, while undefined memory blocks will not be accessed by the
emulator.

ON enable memory mapping
OFF disable memory mapping
-r remove specified meory block or all blocks
addr_block address range to apply mapping mode
type type of access for the specified block.

Supported types are: RAM, ROM, READ, WRITE

Syntax MB

MB {num | *} [-off|-on|-z]
[{-a [comp] spc:addr [acc] [and|then]
[comp] addr [acc]} | {-d{x|y}comp data [acc]}]
[and|then]
[ ... ]
[And]
[ ... ]
[-c count ] [-s] [-t] [-x command ]
with acc = {rw|r|w}
comp = {=|<=|>=|!=}
spc = {p|x|y}

Menu ---

Description Modifies a conditional hardware breakpoint pattern previously defined
(up to 4) or displays the conditional hardware breakpoint settings. If no
parameters are defined, MB displays the current memory conditional
hardware breakpoint settings.
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MB Modify conditional hardware breakpoints

MAP Configure memorry mapping



Parameters:

� num Breakpoint number (1 to 4)
� * All breakpoints.
� -off/-on Breakpoint is set but inactive/active.
� -z Breakpoint is cleared.
� -a spc: Breakpoint address space (p by default, x or y).
� addr Breakpoint address value.
� -dx -dy Breakpoint data space (x or y).
� data Breakpoint data value.
� = <= >= != Breakpoint value comparison (= by default).
� rw r w Breakpoint value access (rw by default).
� and then Breakpoint condition (and by default).
� -c count Breakpoint when count=1, otherwise count is decremented.
� -s No breakpoint, but snapshot samples recording.
� -t Breakpoint trap to stop program execution to display breakpoint

message or to execute a command (option -x and except GO,
NEXT, RUN), then resumes execution.

� -x command Emulator command executed after a breakpoint.

See also SB

Syntax MEM [address]

Menu View → Symbols Dialog

Description The MEM command will set starting address of the Memory window to the
address value. If no parameter is specified, command will cause to scroll
Memory window one page down Command affects only the last selected
Memory window, other Memory windows are not affected.
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MEM Set memory address or Scroll Page Down Memory window



Syntax MIX

Menu Local code window menu

Description The MIX command will change display mode of the last selected Code
window to mixed mode. If the source line information is not available
command will have no effect.

Syntax MM from to [count]

Menu ---

Description The MM command allows to copy count data of memory from address from
to address to.
space may be "x:", "y:" or "p:". Default value for space is "p:". Default value
for count is 1.

Example MM x:10 y:20 4

Syntax NEXT [count]

Menu Process → Next, F10

Description The NEXT command will execute the single step, or jump over the
subroutine calls. The NEXT command can be accessed also with the
function key F10. Count specifies number of the statements to be executed
before refreshing the debugger windows.
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NEXT Execute next statement

MM Move memory

MIX Change Code window display to the mixed mode



Syntax OPEN channel file mode format [length]

Menu ---

Description Opens an input or output channel with a file, for subsequent reading/writing
data from/to the file.

• channel can be a decimal number from 1 to 10.

• file may be the name of any accessible file or the reserved word TTY, in
which case the keyboard or the terminal, whichever is appropriate, is used.

mode

• INPUT the channel is opened for reading from the file;

• OUTPUT the channel is opened for writing to the file;

• APPEND the channel is opened for writing at the end of the file.

format

• ASCII data read or written should be interpreted in ASCII for-mat;

• BINARY data should be interpreted in binary format.

• length expresses the number of bytes read or written in the file. It can be 1,
2, 3 or 4; default value is 1.

The content of a file read through an ASCII channel should be a sequence of
hexadecimal numbers separated by one or more spaces, tabs or newline
characters.
When reading a TTY channel, the numbers will be read from the keyboard
one for each line. Data read or written are truncated if value exceeds the
length given with command.
Once opened for INPUT a channel may be read by using the # operator
fol-lowed by the channel number (e.g., #1) and the data read may be
assigned to any variable handled by the expression evaluator.

Example de -m test_auto
open 1 address input ascii 2
open 2 result output binary
for v0 1 A 1
v1=#1
#2=mx:v1
endfor
close 1
close 2
endm
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OPEN Open i/o channel



Syntax OUTPUT [#(file number)] OFF | TERM | filename [-dec | -hex | -bin] [-ovr]
[-cnt]

Menu ---

Description The OUTPUT command is used to open a text or binary file and use the file
to save data passed from the target DSP chip. The data is passed to the file
when the user's DSP program reaches a software breakpoint.

The OUTPUT command with no parameters displays all open output files.

#(file number)

is the number of a file opened (multiple files can be opened simultaneously).
The file number is optional, the range is 1 to 99. The ASCII text file lists the
data sequentially.

OFF

closes an opened output file. If a file is not specified, all opened files are
closed.

TERM

uses the terminal/monitor (instead of a text file), and display the data.

filename

is the name of the file used for data output.

dec specifies decimal ASCII data representation

hex specifies hexadecimal ASCII data representation. This is the default.

bin specifies binary data format

ovr Overwrite file if the file exists.

cnt Column count for ASCII formats 1..8), or byte count to store into the file for
every target word read in binary format (1..2)

The transfer of the data is invoked from the debugger by the EXEIO
command. This command expects transfer parameters to be stored in the
glabal variables: v20..v24. To automate data transfer, user needs to set a
breakpoint within the DSP code, and specify "execute" and "test" options for
this breakpoint.

Command file, invoked with the breakpoint's "execute" option, will initialize
global variables, and invoke debugger transfer routine with the EXEIO
command. The breakpoint's "test" option will evaluate result of the data
transfer, and if it was successful, it will restart the DSP. Global variables can
be initialized using variables/registers from the user program, or setup by the
user command file.
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OUTPUT Open the file and save data from the target



Global variables definition:

v20 transfer starting address within the DSP memory

v21 number of words to transfer

v22 direction (0x8000 - write, 0x4000 - read) and memory space
(0 - PMEM, 1 - XMEM, 2 - YMEM)

v23 file # to use

v24 error flag set by transfer routine

Examples on entering the output command:

Example 1: Display all currently open output files.

OUTPUT

Example 2: Open �DATA.OUT� file, label it file number 1, and use the file to save data.
Data is saved in decimal with one word per line.

OUTPUT #1 DATA.OUT -d -1

Example 3: Open DATA4.BIN file, overwrite old one if exists, label the file automatically.
Data in DATA4.BIN is in the binary format using 2 bytes for every DSPword.

OUTPUT DATA4.BIN -b -2 -o

Example 4: Read data from the DSP and send it to the Terminal window in hexadecimal
format, 4 words per line.

OUTPUT TERM -h -4

Example of the command file initializing gloabal variables and breakpooint for OUTPUT

transfer

OUTPUT off ;switch off old input streams

OUTPUT data4.txt -o ;this will create an output file (overwrite
existing file)

BREAK p:120 xset_io tv24!=0 ;set a breakpoint, execute transfer, run target
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Example of the command executed, when the breakpoint at address p:120 is reached

eval v20=addrStart ;get the start address to read from the
application variable

eval v21=xferCnt ;initialize count variable

eval v22=0x4001 ;read from XMEM

eval v23=1 ;write to file #1

eval v24=0 ;error flag set if transfer fails

exeio ;execute transfer

break disable ;disable breakpoints

step ;step over the breakpoint

break enable ;reenable the breakpoints

See also EXEIO, INPUT

Syntax PATH [pathname[,OFF]]

Menu ---

Description The PATH command with no parameter will display list of the defined search
paths for the system. Search paths are used to locate object files, source
files and alias commands. If the pathname is specified, it will be added to the
list of the search paths. The OFF parameter will remove specified pathname
or clear all the path list if the pathname was empty.
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PATH Define, display or remove search paths



Syntax PCCURSOR

Menu ---

Description PCCURSOR command is available only for macro command processor and
custommenus of the code window.When invoked, it will change value of the
taget's PC to the current position of the cursor within the code window. If the
current position of the cursor cannot be translated to the PC value,
command will have no effect.
This command can be also assigned to the function keys with the ALIAS
command.

Syntax PAUSE secs

Menu ---

Description Temporization command, waits for secs seconds.

Example Pause 10

Syntax PCHIST

Menu ---

Description PCHIST command displays contents of the emulator's trace buffer

Example + pchist
P:0122 JUMP $103
P:0103 IX0 = #$1
P:0105 IX1 = #$1
P:0107 IY0 = #$1
P:0109 STA = #$C
P:010B AX0 = #$40
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PAUSE Pause for a number of seconds

PCHIST Program counter history

PCCURSOR Set PC value at cursor within code window



Syntax Print [-x | -d | -o] [-n] [-r] [expr] ...

Print [-x | -d | -o] [-n] [-r] -f "C-like-format" [expr] ...

Menu ---

Description The PRINT command allows to print (display) strings and values. It may be
useful when used in macros to print messages and to convert the base of
numbers.

-x specifies the hexadecimal output format.

-d specifies the decimal output format.

-o specifies the octal output format.

Note that expressions in the list of arguments are always interpreted
according the current base, independently from options -x, -d and -o.

-n omits a newline to be printed at the end of a line.

-r displays in reverse video mode.

-f "C-like-format" allows to format output. The same format is applied to all
expr parameters. Follows the ANSI C syntax.

Example print -r "TITLE IN REVERSE"
print -f "value = %04x" 0x0A --> value = 000A
print -f "value = %04d" 0x0A --> value = 0010
print -f "value = %4x" 0x0A --> value = A
print -f "value = %4d" 0x0A --> value = 10
print "value of stack pointer register =" r$SP
print -d "LOOP COUNTER VALUE=" m$LOOPCNT
--> print value (in decimal format) at the address
defined by symbol LOOPCNT

Syntax QUIT

Menu File → Exit

Description The QUIT command will close target connection (if opened), save current
windows configuration, and close the application.
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Syntax REFRESH]

Menu ---

Description The REFRESH command will force update of all debugger windows.

Syntax RELOAD [filename]

Menu ---

Description The RELOAD command will load last loaded code to the target processor.
RELOAD command leaves symbol table intact.

Syntax RESET

Menu Process → Reset

Description The RESET command will reset the target processor to debug mode. This is
the hardware reset using the physical processor reset signal. In
multiprocessor systems it can affect other processors. For the software
reset only, appropriate macro command should be executed.

Syntax RESTART

Menu Process → Restart

Description The RESTART command resets the program to its entry point. This
command assumes, that program is already loaded with the LOAD
command, or symbolic information is entered with the SLOAD command.
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RELOAD Reload program code (no symbols)

RESET Reset target processor

RESTART Reset program to its entry point

REFRESH Refresh display window



Syntax RETURN

Menu Process → Return

Description The RETURN command will execute code in the current C function, and
halts when execution reaches the caller.

Syntax RUN [count]

Menu Process → GO, F5

Description The RUN command executes count of instructions using on target�s �trace
counter�. If the count is omitted, the RUN command will behave as the GO
command with no parameter.

Syntax SAVE address_range [address_range] filename [options]

Menu ---

Description The SAVE command saves memory blocks specified by one of more
definitions of the address_range to the ASCII file in the OMF format
(extension .LOD). This data file can be loaded back to the processor
memory with the LOAD command.

address_range specifies memory area to be changed to the value. Range can be accepted
in two formats: start_address..end_address or
start_address#count.register

Options:

o overwrite an existing file

a append to the existing file

x save in binary format

[1..8] number of words per line (default: 8)

h hexadecimal format (default)

d decimal format
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RUN Execute multiple instructions

SAVE Save memory block(s) to the file

RETURN Exit from subroutine



Syntax SB

SB num [-off|-on]

[{-a [comp] spc: addr [acc] [and|then]

[Comp] addr [acc]} | {-d{x|y}comp data [acc]}]

[and|then]

[ ... ]

[and]

[ ... ]

[-C count ] [-s] [-t] [-x command ]

with acc = {rw|r|w}

comp = {=|<=|>=|!=}

spc = {p|x|y}

Menu ---

Description The SB command sets a new conditional hardware breakpoint (up to 4) or to
display the condi-tional hardware breakpoint settings. These hardware
breakpoints work in a real time context. If no parameters are defined, SB
displays the current memory conditional hardware breakpoint settings.

Parameters:

� num Breakpoint number (1 to 4)
� -off Breakpoint is set but inactive.
� -on Breakpoint is set and active.
� -a spc: Breakpoint address space (p by default, x or y).
� addr Breakpoint address value.
� -dx -dy Breakpoint data space (x or y).
� data Breakpoint data value.
� = <= >= != Breakpoint value comparison (= by default).
� rw r w Breakpoint value access (rw by default).
� and then Breakpoint condition (and by default).
� -c count Breakpoint when count=1, otherwise count is decre-mented.
� -s No breakpoint, but snapshot samples recording.
� -t Breakpoint trap to stop program execution to display breakpoint

message or to execute a command (option -x and except GO,
NEXT, RUN), then resumes execution.

� -x command Emulator command executed after a breakpoint.
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Buses and conditions:

-a p: addr
-a p: addr AND addr

-a p: addr AND -a x: addr
-a p: addr AND -a x: addr AND addr

-a p: addr AND -a x: addr AND -a y: addr
-a p: addr AND -a y: addr
-a p: addr AND -a y: addr AND addr

-a p: addr THEN addr

-a p: addr THEN -a x: addr
-a p: addr THEN -a x: addr AND addr

-a p: addr THEN -a x: addr AND -a y: addr
-a p: addr THEN -a y: addr
-a p: addr THEN -a y: addr AND addr

-a x: addr
-a x: addr AND addr

-a x: addr AND -a y: addr
-a x: addr AND -dx= data

-a x: addr THEN addr

-a x: addr THEN -a y: addr
-a x: addr THEN -dx= data

-a y: addr
-a y: addr AND addr

-a y: addr AND -dy= data

-a y: addr THEN addr

-a y: addr THEN -a x: addr
-a y: addr THEN -dy= data

-dx= data

-dx= data AND -dy= data

-dy= data

There are only 4 internal DSP breakpoint registers, limiting hardware break-point resources. Only one
internal DSP counter exists and it may be affected by 1 to 4 break-points (the count value written is the
last supplied).
The snapshot mode uses conditional breakpoint logic to record bus samples. In this case the end of
program execution occurs when the asked samples number is reached and recorded.

When a breakpoint is met, 1 or 2 instructions are executed.
Remember that one program address breakpoint can be used by simple soft-ware breakpoints.
Do not use SB to modify an existing breakpoint, instead use the MB command.
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Example reset
load test_bp
sb 1 -a p:100
sb 2 -off -a 200 and -a <= x:300 w -t -x line
sb 3 -dy<= 400 r -c 10
sb
go
dr
mb 1 -z
mb 2 -on
mb
go
dr
mb * -z

See also MB, SBPUT

Syntax SBDel <addr 1> [<addr 2> ... ]

SBDel *

Menu ---

Description The SBDEL command deletes simple software breakpoints located at the
specified addresses.

* means all breakpoints.

Example SBDEL $_swi 200

See also SB, SBPUT
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Syntax SBPut addr 1 [ addr 2 ... ]

SBPut

Menu ---

Description The SBPUT command sets simple software breakpoints located at the
specified addresses.

If no parameters are defined, the command reports all the active
breakpoints.

Note: these software breakpoints do not work in a real time context. They
need one program address hardware breakpoint and three words in a valid
stack.

Example SBPUT $_swi 200

See also SB, SBDEL

Syntax SEARCH [space] from to pattern

Menu ---

Description The SEARCH command searches the value pattern in memory, between
from and to addresses.
space may be "x:", "y:" or "p:". Default value for space is "p:", i.e., program

space.

The pattern can consist of 1 to 8 words

If the pattern is found, the display is preceded by the address of memory
where it has been found. The format is similar to that of DM command

Example SE x:100 200 FF00

See also DM
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SBPUT Put/Display simple software breakpoints

SEARCH Search a pattern in memory



Syntax SET [ option [argument]]

Menu ---

Description Displays or changes the setting of the emulator.

option can be: DSPVER, ECHO, GOFROM, LOG, SOURCE, VERBOSE,
MECHO, TAB , WATCH , TIMER, TIME24, ERRORS, TTYLOG,
TTYWRAP, SCROLL

argument can be OFF, ON, or value

DSPVER n decimal value representing version of the ST18950 silicon.

TAB n decimal value representing tab character size in spaces (1..32)

WATCH ms delay time in ms, for displaying instant watch values within code window

TIMER ms delay time in ms between checking the target status. Decreasing this time
will accelerate single step operation, but it will use more PC's CPU time.

TIME24 ON|OFF If the TIME24 option is enabled (ON), time of file creation (DIR command)
will be displayed in the 24 hour format.

ERRORS ON|OFF enabled option will stop execution of the command file, if the error is
detected. If the ERRORS option is set to OFF, macro command will
continue.

TTYLOG ON|OFF enabled option, will LOG all commands to the Terminal window. If the file
logging is enabled, this option is also automatically enabled.

TTYWRAP ON|OFF enabled option, will wrap long lines when the right side of the terminal
window is reached

SCROLL x hexadecimal value limiting window's scroll range. Value can be between
0x100 and maximum address value.

GOFROM ON|OFF enabled option will interpret the address for the GO command, as a start
address - it will change PC value before restarting target. Default is OFF,
which treats address, as "goto" address.

ECHO ON | OFF When set to OFF, no messages are echoed in the terminal window. This
command must be used in a command file. When set to ON, all messages
are echoed again in the terminal window.

LOG <file> ON | OFF If <file> is specified this option makes a typescript of everything printed in the
terminal window into <file>. When argument is OFF the current LOG file is
closed

SOURCE ON | OFF When set to ON, it enables to display the current mnemonic instruction
executed loaded from the assembler source file, if there is one. When set to
OFF, it enables to display the current mnemonic instruction disassembled.
The default selection is OFF when entering the emulator.
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VERBOSE ON | OFF When set to ON, any command, either read from the keyboard, from amacro
or from a command file is echoed before being executed. The commands
are displayed in the terminal window and logged to the log file.

MECHO ON | OFF When set to OFF, no commands are echoed to the command window during
macro execution. When set to ON, during macro command execution, all
commands will be echoed to the command window.

Example set source on
set verbose on
set log trace
set
time
set echo off
go
set echo on
time
set log off

Syntax SLOAD filename

Menu Load → File

Description The SLOAD command loads the symbol table of the specified object file.
SLOAD clears existing symbol table before loading the new one. If the
filename has no extension, systemwill add automatically the .cld extension.

Syntax SM [space] address value

Menu ---

Description The SM command changes the content of the memory at the specified
address.
Space may be "x:", "y:" or "p:". Default value for space is "p:", i.e., program
space.

The content of memory at the address specified is set to that value.

Example cmd> SM x:10 FFFF

See also CM, DM, FM
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SLOAD Load symbol table

SM Set memory



Syntax SOURCE or SRC

Menu Local code window menu

Description The SOURCE (or SRC) command will change display mode of the last
selected Code window to the source mode. If the source line information is
not available command will have no effect.

Syntax SR register value

Menu ---

Description The SR command sets the register indicated by register with the value.

Example cmd> SR ax0 10

• See also DR

Syntax SRC

Menu Local code window menu

Description The SRC command will change display mode of the last selected Code
window to the source mode. If the source line information is not available
command will have no effect.

Syntax START

Menu ---

Description START command resets target and starts execution of the user program.
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SR Set registers

SRC Change code window display to the source mode

START Reset and strat execution

SOURCE Change code window display mode to source



Syntax STATUS

Menu ---

Description The STATUS command checks the target processor status. Status is also
displayed on the right side of the status bar, on the bottom of the application
window.

Syntax STEP [count]

Menu Process → Step

Description The STEP command will single step the target code. If count is not specified
it will step single instruction. For the multi-instruction step, debugger
windows will be refreshed after every step. To execute multiple instructions
without windows refresh, RUN command should be used.

Syntax STEPOVER [count]

Menu Process --> Stepover, F10

Description The STEPOVER command will execute the single step, or jump over the
subroutine calls. The STEPOVER command can be accessed also with the
function key F10. Count specifies number of the statements to be executed
before refreshing the debugger windows.

Syntax STOP

Menu ---

Description The STOP command will enter the target processor into the debug mode,
allowing to access target resources.
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STEP Single step single or multiple instructions

STEPOVER Execute next statement

STOP Stop executing code

STATUS Check target status



Syntax TILE

Menu Window --> Tile

Description Arrange all opened windows in the tile format.

Syntax TIME [mode]

Menu ---

Description This command allows to display current system time, or time in milliseconds
from last TIME command usage.

Parameter mode allows for different display formats:

0 Display full time and date (default)

1 Display time and delta time from last TIME (hh:mm:ss.mmm (msec))

2 Display delta time from the last TIME command (milliseconds)

3 Clear millisecond delta timer (initialize)

Syntax TIMER [value]

Menu ---

Description The TIMER command allows to adjust application idle timer. This timer is
used to periodically check for the target processor status.

Value represents the idle time in milliseconds.

Syntax UNALIAS [name]

Menu ---

Description The UNALIAS command will remove all system aliases if parameter was
empty.
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TIME Get timing information

TIMER Set/get application timer value

UNALIAS Remove alias for given name

TILE Tile all windows



Syntax UNDEFINE {-a | -m} symbol...

UNDEFINE {-a | -m} -all

Menu ---

Description Removes the symbol of the given type from the symbol table, or clears the
entire symbol table if the -all option is specified.

-a Memory address.

-m Macros.

Example un -a lab
un -m LOADANGO

See also ARCHIVE, DEFINE, LISTSYMBOL

Syntax USE [pathname[,OFF]]

Menu ---

Description The USE command with no parameter will display list of the defined search
paths for the system. Search paths are used to locate object files, source
files and alias commands. If the pathname is specified, it will be added to the
list of the search paths. The OFF parameter will remove specified pathname
or clear all the path list if the pathname was empty.

Syntax VERSION

Menu ---

Description The VERSION command will display version numbers of all active
components.
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UNDEFINE Remove symbols

USE Define, display or remove search paths

VERSION Display program version



Syntax VIEW filename

Menu ---

Description Open file in the browser window.

Syntax WAIT time | DEBUG| MAIL

Menu ---

Description This command allows to suspend macro command execution for specified
numner of milliseconds (time), or wait until the target device gets into the
debug mode (DEBUG) (reaches one of the breakpoints).

If parametermail is used it waits until receives acknowledgement for all sent
commands to another debuggers. This feature is available only for
multi-DSP development systems.

Example: Load test.cld
Break main
Go
Wait debug
beep

Syntax WATCH address | register [,label[,mode]]

Menu View → Symbol

Description The WATCH command will add or remove watch variable from the Watch
window.

address should have the following format: space: offset, where space is one of the
allowed memory spaces for the processor (P, X, or Y), offset absolute value
of the address offset. Address can be also specified in the form of the
application symbol.

register is a valid name of one of the target registers
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VIEW Open View window

WAIT Wait for mcsecs or until device is in DEBUG mode

WATCH Add watch variable



label is a string which will be displayed instead of the watch.
address mode is one of the following:

c - ASCII character
d - decimal
e - exponential floating point
o - octal
p - address
s - ASCII string
u - unsigned decimal
x - hexadecimal
r - remove watch from the watch window.

Syntax WINDOW type

Menu View --> win_type

Description Window command allows to open newwindow of the specified type.Window
type can be specified with the partial name only.
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WINDOW Open a new window
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